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1 Sicurezza

1.1 Uso previsto
Device Xpert è un software di configurazione per dispositivi preinstallato sui configuratori 
portatili Field Xpert SFX 100, SFX350 e SFX370. Sono disponibili versioni sia per HART che 
per FOUNDATION Fieldbus. Il software può essere utilizzato per le finalità descritte nel 
presente Manuale operativo. La funzionalità è stata verificata per dispositivi registrati dalla 
HART Communication Foundation e dalla Fieldbus FOUNDATION. Non è garantito che sia 
possibile configurare dispositivi non registrati, benché ciò si verifichi spesso. 

1.2 Messa in servizio e funzionamento
Device Xpert viene fornito già installato su un configuratore portatile Field Xpert. Le 
procedure di messa in servizio e utilizzo dei configuratori Field Xpert SFX350 e SFX370 in 
abbinamento ai relativi modem Bluetooth e ai punti di accesso dell'impianto sono descritte 
nel Manuale operativo di Field Xpert BA01202S/04, mentre le procedure relative a Field 
Xpert SFX100 sono descritte nel Manuale operativo BA00060S/04.

1.3 Sicurezza operativa
Device Xpert è utilizzato per la configurazione di dispositivi in bus di campo. Eventuali 
configurazioni scorrette potrebbero determinare situazioni indesiderate o pericolose in un 
impianto di processo. Pertanto, è estremamente importante che gli utenti del software 
ricevano un adeguato addestramento e siano qualificati e autorizzati ad effettuare la messa 
in servizio di dispositivi in bus di campo. 

1.4 Migliorie tecniche
Endress+Hauser si riserva il diritto di eseguire migliorie tecniche a hardware e software in 
qualsiasi momento e senza preavviso. Queste modifiche non sono documentate, se non 
riguardano il funzionamento del dispositivo. È pubblicata una nuova versione del Manuale 
Operativo se le migliorie hanno effetto sul funzionamento.

1.5 Norme di sicurezza e simboli
In questo manuale, per evidenziare le procedure importanti per la sicurezza o le alternative 
operative, sono utilizzati i seguenti simboli convenzionali posti a margine dell'indicazione. 

Simboli per informazioni 
di sicurezza

Simbolo Significato
PERICOLO
Questo simbolo indica una situazione pericolosa. Se non si evita tale situazione, si 
verificheranno incidenti gravi o mortali.

AVVISO
Questo simbolo indica una situazione pericolosa. Qualora non si eviti tale situazione, si 
potrebbero verificare incidenti gravi o mortali.

ATTENZIONE
Questo simbolo indica una situazione pericolosa. Qualora non si eviti tale situazione, si 
potrebbero verificare incidenti di media o minore entità.

NOTA
Questo simbolo indica informazioni relative a procedure o altri aspetti che non 
comportano rischi di lesioni personali.

PERICOLO

AVVISO

ATTENZIONE

NOTA
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2 Funzionamento e struttura del sistema

2.1 Funzione
Field Xpert di Endress+Hauser è un computer mobile portatile (PDA) industriale a elevate 
prestazioni basato sul sistema operativo Windows Embedded Handheld. Ha dimensioni 
esterne compatte e offre connessioni integrate WLAN, USB, Bluetooth e a infrarossi, che 
consentono la connessione a dispositivi HART e/o FOUNDATION Fieldbus tramite modem o 
gateway. Grazie a un'ampia gamma di approvazioni Ex, Field Xpert risponde ai requisiti 
dell'industria di processo per applicazioni in area pericolosa e sicura. 

Quando l'hardware Field Xpert e il software Device Xpert comunicano con un dispositivo, è 
possibile procedere alla configurazione di quest'ultimo. A seconda dell'architettura di 
sistema, potrebbe risultare visibile un solo dispositivo, ad esempio nel caso di una 
connessione punto a punto HART, o tutti i dispositivi connessi ad un segmento, come nel 
caso di applicazioni FOUNDATION Fieldbus. 

Fig. 2-1: Pagina di avvio di Device Expert per FOUNDATION Fieldbus e live list dei dispositivi connessi

Altre funzioni Tra le altre funzioni, descritte dettagliatamente al Capitolo 3, figurano:

•  Aggiornamenti dei file di descrizione del dispositivo (DD)
•  Curva d'inviluppo 
•  Cartella Preferiti
•  Funzione di ricerca
•  Diagnostica del dispositivo
•  Funzione Upload/Compare
•  Report del dispositivo (XML)
•  Guida dell'applicazione
•  Generic DD
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2.2 Connessione a dispositivi HART
AVVISO
• Quando si introducono dei nuovi dispositivi in un loop, occorre verificare la sicurezza 

intrinseca.

2.2.1 Modem VIATOR Bluetooth
Il modem VIATOR Bluetooth consente di stabilire connessioni punto a punto con un 
dispositivo HART. Esistono due alternative:

•  con normale alimentazione del trasmettitore, es. RMA42: connessione mediante un 
resistore di carico 270 Ω (250 Ω – 1100 Ω) collegato al loop come mostrato in Fig. 2-2

•  con alimentazione del resistore di comunicazione HART incorporato: connessione 
mediante i due ingressi di comunicazione HART posti sul pannello anteriore riprodotto 
in Fig. 2-3. Possono essere utilizzati i seguenti alimentatori per trasmettitori HART:  
– RNS221, RMA422, per applicazioni non-Ex 
– RN221N, RMA421, per applicazioni Ex e non-Ex

La connessione tra Field Xpert e modem è di tipo wireless (Bluetooth). 

NOTA
• Il modem è certificato per l'utilizzo in aree pericolose classificate come Zona 1. Se è stato 

precedentemente impiegato in un'installazione non-Ex, il modem non deve essere 
utilizzato in un'installazione Ex, in quanto vi è il rischio che i circuiti di protezione siano 
stati inavvertitamente sovraccaricati e non funzionino più correttamente.

Connessione mediante 
resistore di carico

Fig. 2-2: Connessione mediante resistore di carico

Connessione tramite 
ingressi HART 
dell'alimentatore

Fig. 2-3: Connessione tramite alimentatore del trasmettitore con ingressi di comunicazione HART 
(resistore di carico interno)

AVVISO

NOTA

+

-

+

-
Dispositivo HART

Alimentazione
trasmettitore
ad es. RMA42

Resistore di carico
250 - 1100 Ohm

Modem VIATOR Bluetooth Field Xpert

Alimentazione
trasmettitore
RMA421
RMA422
RNS221
RN221N

–

+

Dispositivo HART

Modem VIATOR Bluetooth Field Xpert
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2.2.2 Wi-Fi – Connessione punto a punto HART tramite Fieldgate
Due dispositivi HART possono essere collegati direttamente ai canali di ingresso del Fieldgate 
FXA520. Se è stata ordinata la versione adatta del fieldgate, i dispositivi possono essere impiegati 
in aree pericolose. Gli ingressi possiedono i requisiti SIL 2 per loop 4...20 mA (IEC 61508).  
In Fig. 2-4 è riportata l'architettura di sistema: come si può vedere, Field Xpert comunica con il 
Fieldgate tramite un punto di accesso Wi-Fi, e i Fieldgate sono alimentati tramite alimentatori 
per trasmettitori RNS221 o RN221N-B.

Fig. 2-4: Architettura di sistema per connessione punto a punto HART

2.2.3 Wi-Fi – Connessione multidrop HART tramite Fieldgate
Con il modulo multidrop FXN520 possono essere collegati al fieldgate fino a 2x 8 dispositivi 
HART impiegati in area sicura. In Fig. 2-5 è riportata l'architettura di sistema. 

Fig. 2-5: Architettura di sistema per connessione multidrop HART

-
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2.2.4 Wi-Fi – Connessione con multiplexer HART tramite Fieldgate
In Fig. 2-6 è riportata l'architettura di sistema per una connessione con multiplexer HART. 
L'interfaccia RS-485 del Fieldgate FXA520 consente di collegare fino a due multiplexer 
HART, ad es. KFD2-HMM-16 di Pepperl+Fuchs. In questo modo possono essere collegati 
fino a 30 dispositivi HART. Se i dispositivi sono impiegati in area sicura, l'alimentatore/
trasmettitore RNS221 può essere usato per alimentare due dispositivi. I dispositivi Ex 
possono essere installati anche in aree pericolose. In tal caso, il segnale deve essere collegato 
all'alimentatore RN221N-B posto in area sicura. 

Fig. 2-6: Architettura di sistema per connessione con multiplexer HART
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es. 
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-

Visualizzazione SCADA
Punto di
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WiFi

Field Xpert

Ethernet

15                    16
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2.3 Connessione con dispositivi FOUNDATION Fieldbus
AVVISO
• Quando si introducono dei nuovi dispositivi in un loop/segmento, occorre verificare la 

sicurezza intrinseca.

2.3.1 Modem Bluetooth FFblue
Field Xpert comunica con un dispositivo FOUNDATION Fieldbus tramite il modem FFblue 
Bluetooth. La connessione tra Field Xpert e modem è di tipo wireless. Il modem può essere 
collegato a qualsiasi punto del segmento del bus di campo H1, o direttamente ai morsetti per 
bus di campo del dispositivo stesso. Il modem può anche essere utilizzato in aree a rischio di 
esplosione, a patto che il modello di Field Xpert abbinato sia anch'esso certificato per 
applicazioni Ex. 

Fig. 2-7: Connessione del modem FFblue al segmento H1 FOUNDATION Fieldbus

2.3.2 Wi-Fi – Connessione FOUNDATION Fieldbus tramite gateway
In Fig. 2-8 è riportata l'architettura di sistema: come si può vedere, Field Xpert comunica con 
il gateway SFC162 tramite un punto di accesso Wi-Fi. Il gateway SFC162 è collegato in 
parallelo al controllore. Esso dispone di quattro canali, ciascuno dei quali può essere 
collegato a un segmento H1 FOUNDATION Fieldbus diverso. 

Fig. 2-8: Architettura di sistema per rete FOUNDATION Fieldbus (non-Ex)

AVVISO

Controllore con 
alimentazione
bus di campo

Modem FFblue
Field Xpert

FOUNDATION fieldbus H1

SFC162 Visitor 
con alimentazione 

Visualizzazione SCADA

Punto di
accesso
WiFi
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Ethernet

FOUNDATION fieldbus H1

Controllore

Canale 1...4

.
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3 Funzionamento di Field Xpert

3.1 Istruzioni di start-up

3.1.1 Connessioni
NOTA
• La procedura di messa in servizio di Field Xpert è descritta nel Manuale operativo 

BA01202S/04

Connessioni Bluetooth Per poter utilizzare Field Xpert per la configurazione di dispositivi HART o FOUNDATION 
Fieldbus è necessario procedere alla sua messa in servizio. Le operazioni da eseguire 
dipendono dal tipo di connessione utilizzata e di licenza acquistata. In linea generale:

•  se è stata acquistata una licenza Device Xpert HART o HART più FOUNDATION Fieldbus, 
la connessione Bluetooth per HART è già stata configurata e installata in Field Xpert da 
Endress+Hauser prima della consegna

•  se è stata acquista una licenza Device Xpert FOUNDATION Fieldbus o HART più 
FOUNDATION Fieldbus, la connessione Bluetooth per FOUNDATION Fieldbus è già 
configurata e installata in Field Xpert da Endress+Hauser prima della consegna

•  l'utente deve sempre configurare e installare una connessione Wi-Fi

Inoltre, è possibile che l'utente debba configurare e installare una connessione Bluetooth in 
caso di aggiornamento della licenza o qualora si presenti la necessità di riconfigurare il 
modem in seguito a un clean reset di Field Xpert. Questa procedura è descritta nel Manuale 
operativo di Field Xpert BA01202S/04.

Connessioni Wi-Fi Se si deve utilizzare una connessione Wi-Fi con il gateway Fieldgate FXA520 (HART) o 
SFC162 (FOUNDATION Fieldbus), è necessario configurarla preventivamente affinché sia 
possibile utilizzare il software Device Xpert associato. Consultare il Manuale operativo di 
Field Xpert BA01202S/04. 

NOTA
• Il modem Bluetooth VIATOR HART si disattiva se non si registra traffico per 30 minuti, e 

per utilizzarlo è necessario riattivarlo
• Il modem FFblue si disattiva se non si registra traffico per 10 minuti, e per riattivarlo 

occorre collegarlo al bus

NOTA

NOTA
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3.1.2 Accensione
1. Se si utilizza il Fieldgate FXA520 o il gateway SFC162, verificare che i dispositivi siano 

alimentati e che la rete sia operativa

2. Attivare Field Xpert  
(si attiva automaticamente quando si inserisce il connettore USB nel computer)

3. Viene visualizzata la schermata home di Field Xpert: 
– Verificare che sia stata attivata la modalità di comunicazione corretta 
– Per cambiare modalità fare tap sull'icona di comunicazione per aprire la schermata 

Wireless Center e attivare la modalità richiesta facendo tap sul pulsante appropriato; 
Per ulteriori informazioni sulla configurazione wireless consultare il Manuale 
operativo BA01202S/04 di Field Xpert

4. Fare tap sulla versione desiderata del software Device Xpert 
 

5. Viene visualizzata la schermata di avvio della versione di Device Xpert: 

NOTA
• Facendo tap sull'icona di Windows nella barra di navigazione della schermata home di 

Device Xpert, il sistema operativo riduce a icona Device Xpert e ritorna al sistema operativo 
Windows.

• Device Xpert è solo ridotto a icona e viene eseguito in background.

NOTA
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3.1.3 Sincronizzazione della libreria DD (aggiornamenti DD)
Insieme a Device Xpert viene fornito il set più aggiornato di driver dei dispositivi (DD) HART 
e/o FOUNDATION Fieldbus disponibile al momento della configurazione in fabbrica. Per un 
periodo di 60 giorni da tale momento, o nel caso sia stata acquistata una licenza di 
aggiornamento DD opzionale (Servizio di aggiornamento software), Device Xpert si connette 
al server di aggiornamento DD Field Xpert - Device Xpert di Endress+Hauser, su cui sono 
disponibili le librerie DD più aggiornate. Device Xpert rileva automaticamente la presenza di 
un licenza valida, ad esempio nel caso in cui sia stata acquistata successivamente o 
aggiornata. Si consiglia di sincronizzare la libreria durante la configurazione iniziale del 
dispositivo, e successivamente a intervalli regolari (se si possiede una licenza per il Servizio 
di aggiornamento software).

Aggiornamento DD in 
Device Xpert

Per aggiornare la libreria DD del dispositivo, collegare Field Xpert a Internet. Il collegamento 
può essere eseguito:

•  direttamente tramite connessione Wi-Fi oppure 
•  mediante una connessione USB o Bluetooth con il laptop/PC. 

Per attivare la licenza mediante connessione USB o Bluetooth, è richiesto Windows Mobile 
Device Center (Windows 7) o ActiveSync versione 4.5 o successiva (Windows XP). Verificare 
che Windows Mobile Device Center o ActiveSync sia installato sul PC. In caso contrario, 
scaricare Windows Mobile Device Center o ActiveSync dal sito Web di Microsoft e installare 
il pacchetto software.

In base al tipo di connessione selezionata, collegare il cavo USB alla docking station di Field 
Xpert e a una porta USB libera sul PC, oppure attivare le interfacce Bluetooth sul PC e Field 
Xpert.

La seguente procedura è indipendente dal tipo di connessione e di conseguenza vale per tutte 
le connessioni Internet prima descritte.

1. Avviare Windows Mobile Device Center/ActiveSync

2. Se Field Xpert deve accedere a Internet tramite un server proxy, inserire i parametri 
corretti del server, v. Capitolo 3.10.3

3. Avviare Device Xpert e selezionare Device=>Synchronize Library. 

4. La sincronizzazione viene avviata e Device Xpert verifica automaticamente la presenza 
di nuovi file DD 
– Se non vi sono nuovi aggiornamenti dall'ultima connessione, viene visualizzato un 
messaggio

5. Confermare la sincronizzazione facendo tap su Yes 
– Il download viene avviato automaticamente

6. In seguito al download, sarà possibile utilizzare i nuovi driver dei dispositivi
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3.1.4 Aggiornamento dei dati della licenza
Field Xpert viene fornito con una licenza precaricata con valori di fabbrica per il nome e 
l'indirizzo e-mail. Si consiglia di inserire la ragione sociale dell'azienda o il proprio 
nominativo e l'indirizzo e-mail di contatto. 

1. Da Device Xpert HART o Device Xpert FF, selezionare Help=>Maintain Licence 

2. Fare tap sulla tastiera nella parte inferiore della finestra di dialogo e inserire tutti i dati 
di contatto 
– Inserire la ragione sociale/nome e l'indirizzo e-mail 
– Inserire la password, reperibile sul retro del CD-ROM fornito in dotazione 
– Fare tap su Refresh per confermare le modifiche 

3. I dati della licenza sono visualizzati nella parte superiore e inferiore della schermata 
– Product: pacchetto software con licenza installato su Field Xpert 
– Numero della licenza del software Device Xpert  
– Activated on: data di attivazione della licenza 
– DD Updates until: ultima data in cui sarà possibile effettuare il download degli 

aggiornamenti, v. Capitolo 3.1.3
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3.2 Connessione a dispositivi HART
Device Xpert HART è un software di configurazione per l'esecuzione di attività di messa in 
servizio, diagnostica e manutenzione su dispositivi HART registrati presso la HART 
Communication Foundation. È disponibile in inglese e tedesco. Device Xpert HART consente 
la scansione automatica della rete HART e semplifica e velocizza la configurazione e la 
diagnostica dei dispositivi presenti.

NOTA
• Device Xpert HART può essere configurato in modo da eseguire automaticamente la 

scansione ogni volta che si seleziona il menu Scan, v. Capitolo 3.10.2. La configurazione 
del range di scansione, ecc. è identica alla procedura descritta al Passaggio 4 sotto 
riportato.

1. Verificare che Field Xpert sia attivo e che vi sia una connessione Bluetooth o Wi-Fi attiva

2. Avviare il software Device Xpert HART toccando sulla relativa icona nella schermata di 
avvio di Field Xpert 

3. Dalla pagina di avvio di Device Xpert HART, selezionare Device => Scan  

NOTA
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4. Nel menu Initiate Device Scan 
– Verificare che Connection sia impostato sul modem o gateway corretto 

– Aprendo la scheda Connections e toccando un'icona è possibile modificare la 
connessione 

– Per impostazione predefinita, il range di indirizzi (address) è compreso tra 0 e 0, 
che corrisponde a un segnale 4–20 mA/HART 
– Per HART multidrop, impostare il range di indirizzi in modo da coprire tutti gli 

indirizzi di polling HART utilizzati. 
– Se è presente un master HART primario nel loop, fare tap (selezionare) sulla 

casella Secondary. 
– Fare tap sul pulsante Scan 

5. Device Xpert ora ricerca i dispositivi HART nella rete collegata e assegna 
automaticamente i driver (device driver, DD) ai dispositivi connessi 
– Nel caso di 4–20 mA/HART viene visualizzata la pagina di riepilogo della 

configurazione, v. Passaggio 6 
– Nel caso di HART multidrop o Fieldgate FXA520, è possibile che vengano rilevati 

molti dispositivi 

6. Fare tap sul nome di un dispositivo per aprire la pagina di riepilogo della configurazione: 
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3.3 Connessione a un dispositivo FOUNDATION Fieldbus
Device Xpert FF è un software per la messa in servizio, la diagnostica e la manutenzione dei 
dispositivi. È disponibile in lingua inglese e tedesca e supporta dispositivi FOUNDATION 
Fieldbus registrati presso il consorzio Fieldbus Foundation. Device Xpert FF consente la 
scansione automatica della rete FOUNDATION Fieldbus e semplifica e velocizza la 
configurazione e la diagnostica dei dispositivi presenti.

3.3.1 Generazione di una live list

1. Verificare che Field Xpert sia attivo e che vi sia una connessione Bluetooth o Wi-Fi attiva

2. Avviare il software Device Xpert FF e selezionare Device => Scan  

3. Dal menu Initiate device Scan 
– Verificare che Connection sia impostato sul modem o gateway corretto 

– Aprendo la scheda Connections e facendo tap su un'icona è possibile modificare 
la connessione 

– Fare tap sul pulsante Scan 
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4. Device Xpert quindi ricerca i dispositivi FOUNDATION Fieldbus nella rete collegata e 
pubblica una live list 
– Esempio con gateway SFC162 a sinistra, con modem FFblue a destra 
– Nel caso di dispositivi non messi in servizio, normalmente vengono visualizzati il 

nome e l'identificativo del dispositivo 

5. Nel caso di dispositivi messi in servizio, è quindi possibile generare un elenco di blocchi e 
parametri come descritto al Capitolo 3.3.4 
– Per i dispositivi non messi in servizio, proseguire come descritto al Capitolo 3.3.2.



Device Xpert Funzionamento di Field Xpert

Endress + Hauser 17

3.3.2 Impostazione di un tag e di un indirizzo del dispositivo
NOTA
• Questa funzione è destinata principalmente alla messa in servizio di singoli dispositivi con 

connessione punto a punto con un modem o gateway, ad esempio per l'utilizzo su un banco 
di prova.

• Device Xpert identifica i dispositivi messi in servizio e disattiva le voci di menu corrispondenti

1. Fare tap su un dispositivo e tenere premuto 
– Nel menu contestuale visualizzato: fare tap su Tag/Address=> Set Tag 

2. Inserire il tag, fare tap su OK per registrare la modifica 
– Fare tap su OK nel messaggio visualizzato per confermare:  
– Il nuovo tag viene visualizzato nella struttura ad albero 

3. Fare tap su un dispositivo e tenere premuto 
– Nel menu contestuale visualizzato: fare tap su Tag/Address=> Set Address 

NOTA
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4. Selezionare l'indirizzo dal menu a tendina, digitarlo oppure utilizzare il dispositivo di 
scorrimento 
– Fare tap sulla casella di controllo Decimal per passare da indirizzi esadecimali a 

decimali 
– Gli indirizzi compresi tra 0x10 (16) e 0x13 (19) sono riservati ai Bridge 

Gli indirizzi compresi tra 0x14 (20) e 0xF7 (247) sono riservati ai dispositivi da 
campo, e qualsiasi dispositivo con classe BOF "Link Master" deve avere un indirizzo 
inferiore rispetto a un dispositivo con classe BOF "Basic" 
Con un range di indirizzi compatto la scansione del segmento risulta più veloce 

– Fare tap su OK per registrare la modifica e scaricare l'indirizzo sul dispositivo 
(l'operazione richiede tempo) 
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3.3.3 Impostazione di una classe BOF
Se il dispositivo devono essere utilizzato come link master, è possibile cambiare la classe BOF 
impostando "Link Master". Di norma questa funzionalità viene assegnata a un solo 
dispositivo da campo in un segmento H1. Non tutti i dispositivi supportano la funzionalità 
Link master.

1. Fare tap sul dispositivo e tenere premuto 
– Nel menu contestuale visualizzato: fare tap su BOF Class => Set Link Master 

2. Nella finestra di dialogo visualizzata, fare tap su OK per confermare la modifica 

3. Fare tap sul dispositivo e tenere premuto 
– Nel menu contestuale visualizzato: Fare tap su Restart Device 
– Nella finestra di dialogo visualizzata successivamente, fare tap su OK per confermare 

il riavvio 
– In seguito al riavvio la funzionalità "Link Master" sarà attiva sul dispositivo 
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3.3.4 Generazione di un elenco di blocchi e parametri

1. Nella live list, fare tap su un dispositivo e tenere premuto per aprire il menu contestuale 
– Selezionare Fetch Block List per caricare tutti i blocchi dal dispositivo selezionato 
 

In alternativa, fare tap su un dispositivo e fare tap su OK; i blocchi verranno caricati 
nella pagina di scansione 

2. Ora fare tap sul blocco che si desidera aprire 
– Il blocco si apre: se necessario, aprire la struttura ad albero per visualizzare le opzioni 

di menu 
– Per ritornare all'elenco dei blocchi fare tap su Device => Disconnect Block 

NOTA
•  A seconda del DD del dispositivo, non tutti i parametri di ingresso potrebbero essere 

visibili nel relativo blocco. Il blocco "Parameters", tuttavia, contiene tutti i parametri del 
dispositivo non contenuti nelle opzioni di menu.

NOTA
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3.3.5 Modifica della modalità target del blocco
In generale, i parametri di un blocco trasduttore FOUNDATION Fieldbus possono essere 
modificati solo quando il blocco è OOS (out of service, fuori servizio). A questo scopo, è 
possibile procedere dalla live list, dall'elenco dei blocchi o dall'elenco dei parametri, a seconda 
della modalità prescelta per generare l'elenco dei parametri. Dopo aver modificato e scaricato 
tutti i parametri, è necessario reimpostare la modalità target del blocco su Auto.

1. Per mettere fuori servizio tutti i blocchi del dispositivo selezionato, è possibile impostare 
su OOS il blocco Resource nella live list 
– Dalla live list fare tap sul blocco Resource e tenere premuto, quindi selezionare  

Set Target Mode dal menu contestuale 
– In alternativa, dall'elenco dei blocchi fare tap su OOS nell'intestazione della modalità 

del blocco 

2. Nella pagina visualizzata: 
– Rimuovere il segno di spunta da Auto e selezionare OOS 
– Fare tap su OK per eseguire la modifica 

3. Per mettere fuori servizio un singolo blocco si può procedere esattamente come descritto 
in precedenza, selezionando il blocco nella live list 
– Fare tap sul blocco e tenere premuto, quindi selezionare Set Target Mode dal menu 

contestuale oppure dall'elenco dei blocchi e fare tap su OOS nell'intestazione della 
modalità del blocco 

– Nella pagina visualizzata, vedere Passaggio 2, rimuovere il segno di spunta da Auto e 
selezionare OOS 

– Fare tap su OK per eseguire la modifica
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4. Se supportato, per mettere fuori servizio un singolo blocco è possibile procedere anche 
dall'elenco dei parametri 
– Aprire il gruppo di parametri Process (il nome può variare a seconda del dispositivo) 

oppure Parameters  
– Nell'elenco dei parametri, aprire il parametro Block Mode=>Target 
– Impostare il valore su OOS 
– Fare tap sulla freccia gialla e, se necessario, confermare con Yes per eseguire la 

modifica 

5. Riportare i blocchi in servizio come descritto ai Passaggi 1 - 4 sopra riportati, ma 
selezionare l'opzione Auto

3.3.6 Attivazione della visualizzazione del blocco funzione
Di norma Device Xpert non viene utilizzato per la configurazione dei blocchi funzione: questa 
attività viene svolta mediante il software di progettazione per il sistema DCS in uso. Pertanto, 
per impostazione predefinita le informazioni corrispondenti sono nascoste in Device Xpert. 
Se tuttavia si desidera visualizzare i blocchi funzione nell'elenco dei blocchi, è possibile 
attivarli procedendo come descritto di seguito.

1. Dalla pagina di avvio di Device Xpert, selezionare View => Configuration 
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2. Scorrere fino alla scheda Options utilizzando le frecce visualizzate nell'angolo della 
finestra di dialogo Configuration. 

3. Fare tap sulla scheda Options  
– Fare tap sulla casella di controllo Enable Function Blocks per attivare la 

visualizzazione 
– Fare tap su OK per confermare l'impostazione e chiudere la finestra di dialogo 

4. I blocchi funzione verranno quindi visualizzati nell'elenco dei blocchi. 
– Se si attiva questa funzione dopo aver caricato i blocchi funzione di un 

 dispositivo, si dovrà ripetere il comando Fetch Function Block, v. Capitolo 3.3.4 
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3.4 Configurazione dei dispositivi
NOTA
• I blocchi FOUNDATION Fieldbus devono essere messi fuori servizio (modalità Target = 

OOS) affinché sia possibile scaricare sul dispositivo le modifiche apportate ai parametri, v. 
Capitolo 3.3.5. 

I parametri disponibili in un dispositivo variano a seconda del produttore, della tipologia e 
della funzione del dispositivo medesimo. Pertanto, non è possibile descrivere la procedura di 
configurazione di un dispositivo specifico per garantire il suo funzionamento corretto: a 
questo proposito sarà necessario consultare il manuale operativo del dispositivo in 
questione. Si prega di notare inoltre che non tutte le funzioni descritte nel presente capitolo 
sono disponibili in tutti i dispositivi.

3.4.1 Struttura ad albero dei parametri

La procedura di configurazione inizia sempre dalla struttura ad albero dei parametri (HART, 
a sinistra) o dalla struttura ad albero dei blocchi (FOUNDATION Fieldbus, a destra), che 
viene letta dal file DD (Device Description) del dispositivo. Nella tabella riportata di seguito 
sono elencate le caratteristiche principali della pagina della struttura ad albero dei 
parametri:

La barra dell'intestazione della struttura ad albero dei parametri può essere visualizzata o 
nascosta selezionando View=>Header Bar.

NOTA

Pos. Funzione Note
1 Descrizione tag • HART: descrizione tag letta dal dispositivo connesso

• FOUNDATION Fieldbus: Block name
2 Barra dell'intestazione Per i dispositivi HART (come mostrato a sinistra)

• Corrente di loop (nell'esempio il dispositivo è HART 4-20 mA)
• Valore principale (nell'esempio: livello in percentuale)

Per i dispositivi FOUNDATION Fieldbus (come mostrato a destra)
• Valore principale (nell'esempio: percentuale)
• Modalità target del blocco (consentita in nero, effettiva con sfondo verde)

3 Cartella del gruppo di 
parametri

• Fare tap sul nodo per aprire la cartella e visualizzare i relativi 
parametri, v. Capitolo 3.4.2

• Nel caso di FOUNDATION Fieldbus, se i parametri di ingresso non 
sono disponibili nel relativo sottoblocco, il blocco "Parameters" conterrà 
tutti questi parametri per il blocco.

4 Punto di espansione/
riduzione

• con "+" si espande la struttura ad albero per visualizzare i parametri 
sotto il nodo

• con "–" si riduce la struttura ad albero per nascondere i parametri sotto il nodo
5 Cartella dei parametri 

personalizzati
Cartella in cui è possibile salvare una visualizzazione personalizzata dei 
parametri del dispositivo

6 Stato connessione Stato del dispositivo: online o offline
7 Tastiera • Fare tap sull'icona per visualizzare la tastiera

• Quando la tastiera è attiva, fare tap sull'icona per nasconderla
8 Ricerca • Fare tap sull'icona per aprire la funzione di ricerca
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3.4.2 Cartelle dei parametri
Nelle cartelle dei parametri sono raggruppati i parametri di ingresso e uscita associati a 
funzioni specifiche del dispositivo. Nella tabella riportata di seguito sono elencate le 
caratteristiche principali della pagina della struttura ad albero dei parametri: 

Pos. Funzione Note
1 Esplorazione orizzontale Indica la posizione corrente nella struttura ad albero di navigazione

• Facendo tap sul livello superiore è possibile chiudere il livello corrente 
per spostarsi verso l'alto

2 Esplorazione verticale Per spostarsi tra le cartelle dei gruppi di parametri
• Freccia su: per spostarsi nella cartella del gruppo di parametri 

superiore e aprirla
• Freccia giù: per spostarsi nella cartella del gruppo di parametri 

inferiore e aprirla
3 Parametro del dispositivo Valore corrente di un parametro del dispositivo

• Fare tap sul parametro per modificare l'impostazione
– È possibile modificare i parametri normali
– I parametri grigi sono di sola lettura e non possono essere 

modificati
– I parametri rossi non sono stati accettati dal dispositivo da campo

4 Denominazione del 
parametro del dispositivo

Designazione del parametro: selezionare per aprire il menu contestuale; 
v. di seguito
• È possibile modificare i parametri normali
• I parametri in grassetto sono stati modificati in questa sessione
• I parametri grigi sono di sola lettura e non possono essere modificati

Tenere premuto il parametro per aprire il relativo menu contestuale
• Display Help: per visualizzare i contenuti della guida relativi al 

parametro
• Show Valid Range: per visualizzare il campo di valori validi per il 

parametro
• Refresh Value: per eseguire nuovamente la lettura del valore dal 

dispositivo
• Refresh Group: per eseguire nuovamente la lettura del gruppo di 

parametri dal dispositivo
• Refresh Vars On/Off: per attivare/disattivare l'aggiornamento 

automatico del valore selezionato
• Display Error: per visualizzare un errore relativo a un parametro
• My <dispositivo> o My Block: per inserire il parametro selezionato 

nella cartella parametri personalizzata
– Select my device – viene visualizzato il Sottomenu "Add"
– Selezionare Add

5 Disponibilità di una guida 
relativa al parametro

Il triangolo giallo indica che è disponibile una guida in linea per il 
parametro; v. sopra

6 Conferma delle modifiche Per trasferire sul dispositivo da campo tutte le modifiche effettuate nella 
cartella

7 Eliminazione delle modifiche • Se si conferma con YES, verranno eliminate tutte le ultime modifiche 
non già confermate
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3.4.3 Diagnostica del dispositivo (NAMUR NE107)
Con Device Xpert HART e FOUNDATION Fieldbus è disponibile un'opzione che fornisce 
informazioni sullo stato di salute del dispositivo da campo connesso. È possibile visualizzare 
cinque differenti condizioni di stato, che ad esempio permettono di sapere se il dispositivo 
da campo sta funzionando in modo anomalo, se è necessario un intervento di manutenzione, 
ecc. L'icona dello stato di salute corrispondente è visualizzata in alto a destra nella finestra 
dei parametri del dispositivo.

Possono essere visualizzate le seguenti condizioni

NOTA
• Non tutti i dispositivi da campo supportano questa funzionalità. 
• FOUNDATION Fieldbus non supporta questa funzionalità per tutti i tipi di blocchi.

1. Fare tap sul simbolo nell'angolo in alto a destra per visualizzare le informazioni 
diagnostiche 

Simbolo Significato Descrizione
 Anomalia Il dispositivo da campo si è comportato in modo anomalo, pertanto una o 

più variabili del dispositivo (di misura o controllo) sono risultate non valide 
o imprecise

 Controllo funzionale Il dispositivo da campo è in fase di manutenzione e uno o più valori delle 
variabili del dispositivo potrebbero essere (temporaneamente) "congelati" o 
non validi

 Fuori specifica Uno o più valori delle variabili del dispositivo potrebbero essere 
compromessi per la presenza di condizioni ambiente/condizioni operative 
non conformi ai requisiti del dispositivo

 Necessaria 
manutenzione

È necessario eseguire un intervento di manutenzione sul dispositivo da 
campo per assicurarne il funzionamento corretto

 OK Il dispositivo da campo funziona correttamente

NOTA
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3.4.4 Diagnostica relativa ai blocchi o al dispositivo e diagnostica dei 
parametri

Per visualizzare informazioni sullo stato dei blocchi dei dispositivi FOUNDATION Fieldbus e 
informazioni sullo stato dei dispositivi HART che non supportano NAMUR NE107 è anche 
possibile utilizzare il menu View. Per la diagnostica di parametri non configurati 
correttamente è anche possibile utilizzare la funzione Display Error. 

1. FOUNDATION Fieldbus: selezionare View=>Block Status 
HART: selezionare View=>Device Status 

2. I parametri visualizzati costantemente in rosso nell'elenco hanno un errore 
– Aprire la descrizione dell'errore facendo tap e tenendo premuto il nome del 

parametro e selezionando Display Error 
– Verrà quindi visualizzata una casella di testo con la descrizione dell'errore 
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3.5 Curva d'inviluppo 
Device Xpert prevede la visualizzazione della curva dell'inviluppo per tutti i trasmettitori di 
livello Endress+Hauser basati sul Time of Flight che utilizzano il protocollo HART. A questo 
scopo, nella struttura ad albero dei gruppi di parametri è disponibile un gruppo di parametri 
aggiuntivo, Envelope Curve. Per una descrizione completa delle funzioni, consultare il 
manuale operativo del dispositivo connesso. 

1. Dalla struttura ad albero dei gruppi di parametri del dispositivo, fare tap su Envelope 
Curve 

2. Nella pagina dei parametri, impostare i parametri secondo necessità 
(di seguito è riportato solo un esempio; per ulteriori informazioni consultare il manuale 
operativo del dispositivo connesso) 
 

Parametro Significato
Curve Type Determina il tipo di curva da campionare

• Envelope
• FAC
• MAP
• Envelope + FAC

Start Curve Value Valore in metri dal puntale della sonda, da cui deve iniziare il 
campionamento della curva d'inviluppo

End Curve Value Valore in metri dal puntale della sonda, a cui deve terminare il 
campionamento della curva d'inviluppo

Sample Resolution Determina la risoluzione della curva
• Low
• Low-Medium
• Medium
• Medium-High
• High

Execute Curve Fare tap su Execute per avviare il processo di campionamento
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3. Dopo aver modificato i parametri, è necessario scaricarli sul dispositivo facendo tap sul 
segno di spunta giallo nella parte inferiore della pagina 
– Confermare il download con Yes 

4. Fare tap su Execute per avviare il campionamento 
– Se necessario, selezionare Yes per far sì che Device Xpert attenda l'esecuzione di 

eventuali aggiornamenti programmati 
– Viene eseguito il campionamento della curva d'inviluppo, che viene quindi 

visualizzata (questa operazione potrebbe richiedere vari minuti) 

5. Facendo tap sul grafico e tenendo premuto, viene visualizzato un menu contestuale da 
cui è possibile 
– cambiare la presentazione (FAC, Envelope) 
– nascondere la legenda della visualizzazione oppure spostarla in basso a sinistra  

(o in alto a sinistra) 
– eseguire Zoom View/Small View sulla curva d'inviluppo 
– chiudere la curva d'inviluppo (Close Graph) 
– creare un report per una curva d'inviluppo, v. Capitolo 3.8.2 
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3.6 Cartella Preferiti
In ogni file DD è presente una cartella Preferiti denominata My <nome del dispositivo> 
(HART) oppure My Block (FOUNDATION Fieldbus). Serve per memorizzare tutti quei 
parametri che devono essere a portata di mano. È inoltre possibile raggruppare i parametri 
in più sottocartelle.

Aggiunta di una cartella 1. Fare tap sulla cartella My <nome del dispositivo>/My Block e tenere premuto per 
aprire il menu contestuale 

2. Fare tap su Add Folder per aprire la pagina Enter Folder Name  
– Visualizzare la tastiera facendo tap sulla relativa icona 

3. Inserire il nome e fare tap su OK per aggiungere la sottocartella in My <nome del 
dispositivo>/My Block 
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Aggiunta di parametri 4. Aprire la cartella del gruppo di parametri contenente il parametro da aggiungere 
– Fare tap sul nome del parametro da visualizzare e tenere premuto finché non viene 

visualizzato il menu contestuale 
– Selezionare My <nome del dispositivo>/My block quindi Add o 

<Subfolder>=>Add 
– Confermare con OK 
– Il parametro viene aggiunto nella cartella My <nome del dispositivo>/My Block o 

nella sottocartella 

5. Visualizzare i parametri aprendo la cartella My <nome del dispositivo>/My block o la 
sottocartella 

6. I parametri possono essere rimossi dalla cartella My <nome del dispositivo>/My Block 
richiamando il menu contestuale del parametro, facendo tap e tenendo premuto e 
selezionando Remove from "My <nome del dispositivo>/My Block" oppure Remove 
from "<sottocartella>" 
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3.7 Funzione Upload/Compare
La funzione Upload/Compare consente di salvare le configurazioni dei dispositivi HART 
sotto forma di immagine offline caricata in Field Xpert. Grazie a questa immagine, è possibile 
visualizzare facilmente la configurazione corrente del dispositivo, confrontarla con 
dispositivi precedenti e verificarla.

3.7.1 Upload

1. Caricare l'immagine corrente del dispositivo connesso selezionando Device=>Upload/
Compare 
– Selezionare Device Image Upload 
– Selezionare Yes nel messaggio di conferma visualizzato 

2. Nella pagina visualizzata successivamente, inserire le informazioni relative al 
salvataggio del file: 
– Il nome predefinito del file è composto da: tag, data e ora del giorno (può essere 

modificato) 
– Fare tap su OK per salvare 

3. Field Xpert carica la configurazione corrente del dispositivo salvandola in un file .img  
nel percorso \SD Card\IMAGES: 
– Se l'upload è eseguito correttamente, viene visualizzato un messaggio 

corrispondente. 
– Fare tap su OK per confermare
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3.7.2 Funzione di comparazione "Compare"

1. Aprire il file dell'immagine caricata con cui si desidera confrontare la configurazione 
corrente del dispositivo, selezionando Device=>Upload/Compare 
– Selezionare Open Upload Image 

2. Nella pagina Open visualizzata successivamente 
– Fare tap sul file da aprire 
– Se il nome del file non è leggibile, impostare Field Xpert SFX350/370 sulla 

visualizzazione orizzontale (nel caso di Field Xpert SFX100, premere il tasto F1 per 
alcuni secondi per passare alternativamente da visualizzazione verticale a 
orizzontale e viceversa) 

– È possibile regolare la larghezza delle colonne facendo scorrere il cursore sulla linea 
di separazione (come in Excel) 

3. Il file dell'immagine viene aperto in una nuova scheda 
– Spostandosi tra i gruppi di parametri è possibile controllarne le impostazioni precedenti 
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4. Per confrontare la configurazione on-line con l'immagine precedentemente 
memorizzata, selezionare Device=>Upload/Compare 
– Selezionare Compare (possibile solo se è selezionata la scheda dell'immagine) 
 

 
– Selezionare Yes nei messaggi di conferma visualizzati

5. In seguito al confronto viene visualizzato un messaggio in cui sono riepilogati i 
cambiamenti 

6. Fare tap su OK per visualizzare la struttura ad albero di confronto dei parametri 
– I gruppi di parametri e i parametri che presentano delle differenze sono evidenziati 

in rosso 

NOTA
• La funzione Compare non distingue tra parametri dinamici (di uscita) e statici, pertanto è 

normale riscontrare delle differenze tra i gruppi di parametri

NOTA
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7. Fare tap su una cartella evidenziata per visualizzare le modifiche in dettaglio 

8. Fare tap e tenere premuto un parametro evidenziato per visualizzare il valore di 
configurazione on-line 
 

 
– Selezionando Reset Comparison Results è possibile rimuovere i risultati del 

confronto evidenziati

9. Chiudere l'immagine selezionando Device=>Upload/Compare=>Close 
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3.8 Report dei blocchi e del dispositivo

3.8.1 Creazione di report del dispositivo (Device Xpert HART)
Per finalità di documentazione, è possibile creare un report della configurazione dei 
dispositivi online, che verrà salvato sul PDA. 

1. Per creare un report con la configurazione del dispositivo, selezionare Device=>Create 
Device Report 

2. Nella pagina visualizzata successivamente, inserire il nome del file 
– Il nome predefinito del file è composto da: tag, data e ora del giorno (può essere 

modificato) 
– Fare tap su OK per salvare 

3. Field Xpert salva la configurazione corrente del dispositivo in un file XML con foglio di 
stile XSL nella posizione \SD Card\REPORTS 
– Se il salvataggio viene eseguito correttamente, viene visualizzato un messaggio per 

indicarlo 
– Fare tap su OK per confermare

4. Il report del dispositivo può essere visualizzato in Internet Explorer sul PDA o su un PC. 
Su un PC è possibile importarlo in Excel
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3.8.2 Creazione di report delle curve d'inviluppo (Device Xpert 
HART)

Il grafico della curva d'inviluppo (v. Capitolo 3.5) può essere salvato sotto forma di immagine. 

1. Per creare un report (immagine) di una curva d'inviluppo, fare tap sulla scheda della 
curva d'inviluppo e tenere premuto, quindi fare tap su Create Envelope Report.  

2. Nella pagina visualizzata successivamente, inserire il nome del file 
– Il nome predefinito del file è composto da: tag, data e ora del giorno (può essere 

modificato) 
– Inserire eventuali commenti nell'apposita casella 
– Fare tap su OK per salvare 

3. Field Xpert salva il report in un file XML con un foglio di stile XSL nella posizione \SD 
Card\REPORTS 
– Se il salvataggio viene eseguito correttamente, viene visualizzato un messaggio per 

indicarlo 
– Fare tap su OK per confermare

4. Il report della curva d'inviluppo può essere visualizzato in Internet Explorer sul PDA o su 
un PC. Su un PC è possibile importarlo in Excel
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3.8.3 Creazione di report dei blocchi (Device Xpert FF)
Per finalità di documentazione, è possibile creare un report della configurazione dei blocchi 
di dispositivi FOUNDATION Fieldbus online, che verrà salvato in un file XML sul PDA. 

1. Per creare un report della configurazione dei blocchi, selezionare Device=>Create Block 
Report mentre il blocco desiderato è connesso 

2. Nella pagina visualizzata successivamente, inserire il nome del file 
– Il nome predefinito del file è composto da: tag, blocco, data e ora del giorno (può 

essere modificato) 
– Fare tap su OK per salvare 

3. Field Xpert salva la configurazione corrente dei blocchi in un file XML con foglio di stile 
XSL nella posizione \SD Card\REPORTS 
– Se il salvataggio viene eseguito correttamente, viene visualizzato un messaggio per 

indicarlo 
– Fare tap su OK per confermare

4. Il report dei blocchi può essere visualizzato in Internet Explorer sul PDA o su un PC. Su 
un PC è possibile importarlo in Excel
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3.8.4 Visualizzazione dei report su un PDA

1. Fare tap su Reports nella schermata di avvio 

2. Nella cartella che si apre successivamente, fare tap sul report desiderato 
– Se il nome del file non è leggibile, impostare Field Xpert SFX350/370 sulla 

visualizzazione orizzontale (nel caso di Field Xpert SFX100, premere il tasto F1 per 
passare alternativamente da visualizzazione verticale a orizzontale e viceversa) 

3. Il report XML (HART a sinistra, FOUNDATION Fieldbus a destra) viene visualizzato con 
Windows Internet Explorer utilizzando il foglio di stile (qui è visualizzato in modalità 
orizzontale con il carattere più piccolo) 
 

 
– Scorrere verso il basso per visualizzare ulteriori informazioni
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3.8.5 Backup/copia di report e immagini
Utilizzando una connessione Windows Mobile Device Center o ActiveSync tra Field Xpert e 
un PC o laptop, è possibile visualizzare ed eseguire il backup di report e immagini del 
dispositivo.

1. Assicurarsi che la connessione Windows Mobile Device Center o ActiveSync sia attiva

2. Avviare Windows Explorer sul PC o Laptop

3. Raggiungere la scheda SD nella cartella Mobile Device 

4. Le immagini di configurazione e i report del dispositivo si trovano nelle cartelle IMAGES 
e REPORTS

5. Copiare i file desiderati, incluso il foglio di stile XSL, in una cartella separata sul PC o 
laptop

3.8.6 Visualizzazione dei report su un PC/laptop
I report possono essere visualizzati aprendo i file corrispondenti in Internet Explorer. Si noti 
che il foglio di stile deve trovarsi nella stessa cartella del report. 
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3.9 Funzioni addizionali

3.9.1 Funzione di ricerca
Se non si conosce la posizione nel DD di un parametro specifico o una funzione speciale si 
può utilizzare la funzione di ricerca integrata. 

1. Selezionare l'icona della lente d'ingrandimento nella barra dei menu inferiore 

2. Nella pagina di ricerca, inserire il nome del parametro da ricercare (o parte di esso) nel 
campo di testo, quindi fare tap su Search 

3. Sarà fornito un elenco di tutti i parametri che contengono il termine cercato. 
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4. Fare tap sul parametro per raggiungere la cartella dei parametri 
– Il parametro ricercato è evidenziato in giallo 

5. Fare tap sulla lente d'ingrandimento per ritornare all'elenco di ricerca; v. Passaggio 3

6. Per eliminare il risultato della ricerca fare tap su un parametro e tenere premuto 
– Nel menu contestuale fare tap su Clear Search Results 

7. I parametri vengono visualizzati come di consueto: 
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3.9.2 Guida dell'applicazione
In Device Xpert è disponibile una guida dell'applicazione contenente informazioni 
dettagliate. 

1. Aprire la guida dell'applicazione selezionando Help=>Application Help 

2. Viene visualizzato l'elenco degli argomenti 
– Fare tap sull'argomento di interesse 
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3.9.3 Informazioni sul dispositivo (HART)
Device Xpert HART offre una panoramica delle informazioni relative al dispositivo

1. Per aprire la pagina delle informazioni su un dispositivo: 
– Fare tap sulla riga del dispositivo e tenere premuto, quindi selezionare Device 

Information dalla finestra del menu contestuale 
– oppure selezionare View=>Device Information dal menu principale 

2. Le informazioni vengono visualizzate 

3. Chiudere la pagina Device Information selezionando OK
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3.9.4 Informazioni sul dispositivo e proprietà dei blocchi (FF)
In Device Xpert FF è disponibile una panoramica delle informazioni sul dispositivo e delle 
proprietà dei blocchi

1. Per aprire la pagina delle proprietà di un dispositivo o dei blocchi: 
– Fare tap sulla riga del dispositivo o del blocco e tenere premuto 
– Selezionare Device Information oppure Properties dalla finestra del menu 

contestuale 

2. Vengono visualizzate le informazioni sul dispositivo o le proprietà del blocco 
– Esempio: dispositivo a sinistra, blocco a destra 

3. Chiudere la pagina Device Information o Properties selezionando OK
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3.9.5 Informazioni sul driver DD (descrizione del dispositivo)
Per ottenere informazioni sui driver dei dispositivi disponibili, procedere come indicato di 
seguito:

1. Nell'elenco dei blocchi, fare tap su View => Device Description Info 

2. Vengono visualizzate le informazioni sui DD file disponibili per il dispositivo on-line 

3. Fare tap su OK per chiudere la finestra di dialogo

3.9.6 Generic DD
Device Xpert HART supporta i file HART Generic DD. Questa funzione garantisce che l'utente 
di Field Xpert sia in grado di effettuare la configurazione base di dispositivo HART, anche se 
il file DD specifico non è disponibile in Field Xpert.

1. Aprire Device Xpert, quindi aprire la pagina Scan con Device=>Scan

2. Nel menu Scan, fare tap su Scan

3. Una volta trovato il dispositivo, fare tap sul nome

4. Se Field Xpert non trova un file DD registrato, caricherà automaticamente il file  
Generic DD 
– Confermare i messaggi eventualmente visualizzati con Yes o OK
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3.10 Menu Configuration
In Device Xpert HART e Device Xpert FOUNDATION Fieldbus è presente un menu di 
configurazione, in cui sono raggruppate tutte le finestre di dialogo relative alla 
configurazione. Alcune vengono richiamate durante la messa in servizio, mentre altre 
offrono opzioni supplementari o permettono di visualizzare informazioni sul dispositivo. Per 
richiamare il menu occorre selezionare View => Configuration. 
 

 
La finestra di dialogo Configuration comprende varie schede che possono essere selezionate 
facendo direttamente tap su di esse. Utilizzando le frecce in basso a destra è possibile 
selezionare le schede nascoste.

3.10.1 Connessioni
Nella finestra di dialogo Connections sono visualizzate le connessioni disponibili per Device 
Xpert (HART a sinistra, FOUNDATION Fieldbus a destra). 

1. Facendo tap su Add Connection è possibile configurare una nuova connessione; 
consultare il Manuale operativo di Field Xpert BA01202S/04. 

2. Nel caso dei dispositivi HART, fare tap e tenere premuto su un'icona di connessione e 
quindi, selezionando il menu Properties viene visualizzata una pagina con: 
– modalità predefinita funzionamento Master 
– range di indirizzi predefinito 
– opzione di scansione automatica, v. Capitolo 3.10.2
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3.10.2 Scansione automatica HART
Nel caso di Device Xpert HART, la scansione automatica può essere configurata dal menu 
Connection procedendo come segue:

1. Fare tap e tenere premuto sulla connessione Fieldgate FXA520, quindi selezionare 
Properties 
– Viene visualizzato il menu Connection Configuration: 

2. Fare tap sulla casella di controllo Automatic per attivare la scansione automatica 
– Se necessario, configurare il range di scansione come descritto al Capitolo 3.2. 
– Premere OK per salvare le modifiche e ritornare alla pagina di scansione

3. In seguito alla configurazione iniziale, per avviare la scansione occorre premere il 
pulsante Scan 

4. Successivamente, ogni volta che si apre il menu Scan, la scansione del dispositivo viene 
avviata automaticamente 
– I parametri possono comunque essere modificati durante la scansione, ma per 

avviare una scansione con i nuovi parametri è necessario fare tap sul pulsante 
Restart Scan  
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3.10.3 HTTP Proxy
Se Field Xpert deve accedere a Internet tramite un server proxy, occorre utilizzare la finestra 
di dialogo HTTP Proxy.

1. Attivare la finestra di dialogo facendo tap sulla casella di controllo Activate HTTP Proxy

2. Inserire i dati richiesti per il proxy in uso

3. Fare tap su Test the proxy settings per verificare che sia possibile accedere a Internet 

3.10.4 Device library
Nella finestra di dialogo Device library è visualizzato un elenco di tutti i file delle descrizioni 
dei dispositivi (Device Description/DD) (HART o FOUNDATION Fieldbus) supportati da 
Device Xpert. È possibile aprire la struttura ad albero per visualizzare i nomi dei dispositivi e 
le versioni dei file DD. 

Per visualizzare ulteriori informazioni tramite il menu contestuale, fare tap su una cartella 
qualsiasi e tenere premuto.
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3.10.5 Paths
Nella finestra di dialogo Paths sono visualizzati i percorsi in cui sono salvati il programma 
Device Xpert e i file DD. Inoltre, qui è possibile controllare la funzione di memorizzazione dei 
log di Field Xpert. Se la funzione è attivata, i log vengono salvati in 
\Programs\DeviceXpert\log_hart.txt o log_ff.txt. 

3.10.6 Options
La finestra di dialogo Options controlla le varie funzioni di Device Xpert, ad esempio se il 
dispositivo deve visualizzare "My <nome dispositivo>/My Block o un elenco di blocchi di un 
dispositivo HART o FOUNDATION Fieldbus. 
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3.10.7 Modem
Nella finestra di dialogo Modem sono elencati i modem Bluetooth attualmente associati a 
Field Xpert; da qui è inoltre possibile selezionare il modem predefinito per l'applicazione 
corrente. 

Nella schermata sono inoltre visualizzate informazioni relative al modem in connesso, come 
la versione del software e il livello di carica della batteria del modem in uso.
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4 Ricerca guasti
Normalmente i prodotti hardware e software funzionano senza presentare anomalie. 
Tuttavia, Endress+Hauser non può garantirlo al 100%. Di conseguenza, ecco di seguito 
alcuni suggerimenti e soluzioni per gestire eventuali guasti.

4.1 Reinstallazione di Device Xpert
NOTA
• Per la reinstallazione, il laptop/PC deve essere connesso a Internet tramite Windows 

Mobile Device Center o ActiveSync. Prima di procedere è pertanto necessario installare 
una di queste applicazioni.

I file di installazione di Device Xpert si trovano sulla scheda SD di Field Xpert. In seguito a un 
clean reset, è necessario reinstallarli nella memoria del dispositivo di Field Xpert e riattivare 
la licenza. 

1. Eseguire un clean reset: consultare il Manuale operativo di Field Xpert BA01202S/04 
– La routine di installazione viene avviata automaticamente al termine del reset.

2. Field Xpert quindi chiede di stabilire la connessione a Internet 
– In seguito all'attivazione della connessione a Windows Mobile Device Center o 

ActiveSync, fare clic su OK per proseguire 
– Se non è possibile stabilire una connessione a Internet, la libreria DD non verrà 

aggiornata e la licenza non verrà riattivata automaticamente durante la routine 
di installazione. Tale operazione dovrà quindi essere eseguita manualmente in 
seguito, v. Capitoli 3.1.3 e 3.1.4. 

3. Viene visualizzato il messaggio Proxy Configuration  
– Se Field Xpert deve essere utilizzato con un server proxy, inserire Y e fare tap su OK;  

diversamente inserire N e fare tap su OK: la procedura ora prosegue con il Passaggio 4 
– Inserire l'indirizzo del server proxy in Proxy Address e la porta del server proxy in 

Proxy Port, confermando ogni dato inserito con OK 

NOTA
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4. Mediante la connessione a Internet Field Xpert: 
– sincronizza la libreria DD 
– attiva la licenza 
Questa procedura potrebbe richiedere diversi minuti. 
– Se non è presente una connessione a Internet, tale operazione dovrà essere eseguita 

manualmente in seguito, v. Capitoli 3.1.3 e 3.1.4.

5. Field Xpert ora esegue l'associazione dei modem Bluetooth 
– Nel caso di un modem HART Bluetooth, proseguire con il Passaggio 6 
– Nel caso di modem HART Bluetooth e FFblue, proseguire con i Passaggi 6 e 7 
– Nel caso di un modem FFblue, proseguire con il Passaggio 7

6. Viene quindi visualizzato un messaggio relativo al modem HART 
– Attivare il modem HART Bluetooth e fare tap su OK 
– Fare tap su OK per passare alla schermata di selezione 
– Nella schermata di selezione, fare tap su un modem e quindi fare tap su Next - Il 

modem viene quindi associato 
–  Con Refresh viene aggiornato l'elenco di selezione dei modem 

– Se si dispone solamente di Device Xpert HART, procedere con il Passaggio 8, 
altrimenti con il Passaggio 7 

7. Viene quindi visualizzato un messaggio relativo al modem FOUNDATION Fieldbus 
– Attivare il modem FFblue e fare tap su OK 
– Fare tap su OK per passare alla schermata di selezione 
– Nella schermata di selezione, fare tap su un modem e quindi fare tap su Next - Il 

modem viene quindi associato 
– Con Refresh viene aggiornato l'elenco di selezione dei modem 
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8. Field Xpert ora completa l'installazione 
– Viene visualizzato un pop-up in cui si comunica che la procedura di installazione è 

terminata.  
Tale messaggio rimane visualizzato per 15 s, dopodiché viene eseguito un riavvio. 

9. Field Xpert viene riavviato e in seguito al riavvio viene nuovamente visualizzata la 
schermata home standard 
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4.2 Anomalie di connessione
Tutti i tipi di connessione (modem Bluetooth, FXA520 e SFC162) dovrebbero funzionare 
senza guasti o interruzioni. Se si rileva una anomalia di comunicazione (i valori nel file DD 
sono di color rosso), controllare le connessioni come indicato di seguito.

NOTA
• Tutti i numeri di capitolo riportati nella tabella seguente si riferiscono al Manuale 

operativo hardware di Field Xpert BA01202S/04 

NOTA

Errore Causa/rimedio
Il modem VIATOR Bluetooth  
non si connette

Errore di comunicazione
• Comunicazione Bluetooth tramite modem o Field Xpert non attivata
• Batterie scariche (<10%), v. Capitolo 4.2.4 - sostituire le batterie
• Comunicazione bloccata: disattivare Field Xpert e il modem, attendere 10 

secondi, riattivare il modem, attendere 10 secondi, attivare Field Xpert
Impostazioni di comunicazione non corrette
• Verificare che sia stato selezionato il modem VIATOR corretto
• Verificare che il modem sia stato configurato correttamente, v.  

Capitolo 6.3.1
• Verificare che il modem sia stato selezionato come modem predefinito

Il modem Bluetooth FFblue  
non si connette

Errore di comunicazione
• Comunicazione Bluetooth tramite modem o Field Xpert non attivata

– Il modem passa in modalità sospensione se non vi è traffico per un 
periodo specificato (10 min)

– Per riattivarlo, disconnetterlo dal bus di campo, quindi riconnetterlo al 
bus di campo

• Batterie scariche (<10%), v. Capitolo 4.4.2 - sostituire le batterie
• Comunicazione bloccata: disattivare Field Xpert e scollegare il modem, 

attendere 10 secondi, ricollegare il modem, attendere 10 secondi, attivare 
Field Xpert

Impostazioni di comunicazione non corrette
• Verificare che sia stato selezionato il modem FFblue corretto
• Verificare che il modem sia stato configurato correttamente, v.  

Capitolo 6.3.2
• Verificare che il modem sia stato selezionato come modem predefinito

Fieldgate FXA520 non si 
connette

Errore di comunicazione
• Comunicazione Wi-Fi tramite Fieldgate FXA520 o Field Xpert non attivata
• Comunicazione bloccata: disattivare Field Xpert e l'FXA520, attendere 10 

secondi, riattivare l'FXA520, attendere 10 secondi, attivare Field Xpert
Impostazioni di comunicazione di Field Xpert non corrette
• Controllare che sia stato selezionato Fieldgate FXA520
• Verificare che il Fieldgate FXA520 sia stato configurato correttamente,  

v. Capitolo 6.4.2
Impostazioni di comunicazione del Fieldgate FXA520 non corrette
• Verificare che gli indirizzi di rete Ethernet siano stati configurati 

correttamente
Per ulteriori informazioni consultare il manuale operativo del Fieldgate 
FXA520

Il gateway SFC162 non si 
connette

Errore di comunicazione
• Comunicazione Wi-Fi tramite gateway SFC162 o Field Xpert non attivata
• Comunicazione bloccata: disattivare Field Xpert e l'SFC162, attendere 10 

secondi, riattivare l'SFC162, attendere 10 secondi, attivare Field Xpert
Impostazioni di comunicazione di Field Xpert non corrette
• Verificare che sia stato selezionato il gateway SFC162
• Verificare che il gateway SFC162 sia stato configurato correttamente, v. 

Capitolo 6.4.3
Impostazioni di comunicazione del gateway SFC162 non corrette
• Verificare che l'SFC162 funzioni in modalità "visitor"
• Verificare che gli indirizzi di rete Ethernet siano stati configurati 

correttamente
Per ulteriori informazioni consultare il manuale operativo del gateway 
SFC162

La connessione USB di Field 
Xpert con un PC non funziona

Connessione a Windows Mobile Device Center/ActiveSync persa
• Disconnettere e riconnettere la porta USB
• Riavviare il PC
• Scegliere una delle due opzioni visualizzate 

– Si consiglia di scegliere "Connect without configuration"
Connessione Wi-Fi funzionante in parallelo
• Configurare ActiveSync in modo che accetti una connessione wireless 

parallela
• Se necessario, rivolgersi al proprio consulente IT
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4.3 Anomalie software

4.4 Aggiornamenti DD
Se si presenta la necessità di sincronizzare la libreria DD, ad esempio quando verranno 
commercializzati nuovi dispositivi, si può procedere utilizzando il servizio di aggiornamento 
DD (Software Update Service) con il codice d'ordine SFX301, fornito dall'ufficio vendite 
Endress+Hauser locale. Endress+Hauser chiederà di fornire il numero di serie di Field Xpert.

Il servizio di aggiornamento DD viene attivato per il modello di Field Xpert in uso, affinché 
l'utente possa sincronizzare la libreria.

Per ottenere ulteriori informazioni sulle modalità d'ordine:

•  Utilizzare il configuratore nella pagina Internet del prodotto: www.endress.com È 
Selezionare il paese È Strumentazione È Componenti di sistema e registratori È 
Configuratori È Field Xpert SFX100/Field Xpert SFX350/Field Xpert SFX370 È 
Funzione pagina di prodotto: configura questo prodotto

•  Oppure rivolgersi all'Ufficio Endress+Hauser locale: www.addresses.endress.com

Errore Causa/rimedio
Device Xpert si blocca Errore software

• Nessun errore software: l'esecuzione della funzione richiede tempo
• Comunicazione bloccata: disattivare Field Xpert e il modem/gateway, 

attendere 10 secondi, riattivare il modem/gateway, attendere 10 secondi, 
attivare Field Xpert

• Device Xpert si arresta in modo anomalo: eseguire un soft reset, v. Capitolo 
7.1.1 del Manuale operativo BA01202S/04

Impostazioni di comunicazione non corrette
• Verificare che sia presente un modem associato e pronto per l'uso, v. 

Capitolo 6.8 del Manuale operativo BA01202S/04
Tutti i valori dell'elenco parametri 
diventano rossi 

Comunicazione interrotta
• Verificare il modem/gateway, v. Capitolo 4.2

Impossibile modificare i parametri Field Xpert è protetto in scrittura, oppure è stato selezionato un livello di 
accesso ai dispositivi errato
• Disattivare la protezione scrittura oppure impostare il livello di accesso ai 

dispositivi corretto, ad esempio selezionando la modalità Service 
(a questo scopo è necessario inserire il codice di servizio)

Il menu Service non è visualizzato È stato selezionato un livello di accesso ai dispositivi errato
• Impostare il livello di accesso ai dispositivi corretto, ad esempio 

selezionando la modalità Service 
(a questo scopo è necessario inserire il codice di servizio)

Impossibile scaricare le modifiche 
apportate ai parametri 
FOUNDATION Fieldbus

Errore dell'operatore
• Impostare Set Target Mode su OOS e riprovare, v. Capitolo 3.3.5

Le variabili dinamiche non si 
aggiornano

Funzionamento normale
• Per mantenere basso il tenore di scambio dati con il protocollo HART 

l’impostazione iniziale prevede che le variabili dinamiche non siano 
aggiornate automaticamente. Questo stato può essere modificato 
manualmente: 
– Selezionare View=>Configuration=>Options
– Selezionare Poll all Dynamic every X seconds e inserire il numero di 

secondi desiderato
– Selezionare OK per chiudere e confermare.
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